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PXIe-5842 Product Overview

What is the PXIe-5842?
The PXIe-5842 is a modular RF vector signal transceiver (VST). The PXIe-5842
module combines with other modules to form complete PXIe-5842 instruments.

The PXIe-5842 combines a vector signal generator and vector signal analyzer with
FPGA-based, real-time signal processing and control.

The PXIe-5842 name encompasses the following instruments:

Table 1. PXIe-5842 Instruments

Instrument Constituent Modules

PXIe-5842 VST
■ PXIe-5842
■ PXIe-5655

Components of a PXIe-5842 System
The PXIe-5842 is designed for integration into a broader test system that requires
test software, drivers, and, in addition to the parts included in your kit, hardware
beyond the PXIe-5842 itself. Use the following list of typical PXIe-5842 system
components as a starting point for building your test system.

PXIe-5842 VST Kit Contents
■ PXIe-5842
■ PXIe-5655
■ Cables

Cable Type Part Number Quantity

Semi-rigid cable, PXIe-5842
REF: IN to PXIe-5655

136103A-01 1
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Cable Type Part Number Quantity
REF OUT, 2.92 mm to
2.92 mm
Semi-rigid cable, PXIe-5842
RF OUT: LO IN to PXIe-5655
LO 0 OUT, 2.92 mm to
2.92 mm

136104A-01 1

Semi-rigid cable, PXIe-5842
RF IN: LO IN to PXIe-5655
LO 1 OUT, 2.92 mm to
2.92 mm

136106A-01 1

■ SMA driver bit
■ Screwdriver
■ PXIe-5842 Safety, Environmental, and Regulatory Information
■ PXIe-5655 Safety, Environmental, and Regulatory Information

Other Hardware Components
A complete PXIe-5842 system also requires equipment that is not included in the kit
for your PXIe-5842 instrument.

■ A PXI Express chassis. Use a chassis capable of meeting the conditions
stated in the Conditions section of the PXIe-5842 Specifications and in
PXIe-5842 System Requirements.
■ A PXI Express embedded controller or MXI controller compatible with your
chosen chassis.
■ PXI chassis slot blockers and EMC filler panels for unoccupied slots of the
chassis.
■ A 0.9 N · m (8 lb · in.) calibrated torque wrench, 5/16 in., NI part number
751120-01.
■ A small flat blade screwdriver.
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Software Components
• Application development environment—Development environments that

support the development of applications that make use of the PXIe-5842 in
supported programming languages.

■ LabVIEW
■ LabWindows™/CVI
■ C/C++
■ C# (.NET)
■ InstrumentStudio

• Driver software—Drivers that provide the API for controlling and taking
measurements with the PXIe-5842.

■ RFmx
■ NI-RFSG
■ NI-RFSA

The version of the driver you install must provide support for your instrument.
Refer to the release notes or readme for a driver to determine which versions of
the driver support your instrument.

Note Driver software should be installed after you install any
application development environment.

Related information:
■ NI software downloads
■ NI software release notes

PXIe-5842 System Requirements
Your system must meet the following minimum requirements to use the PXIe-5842.
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Chassis Requirements
• Slot cooling capacity—Must be ≥82 W
• Clearances—Maintain the minimum required clearances around your PXI

Express chassis. Clearances may vary by chassis. Follow the guidelines in the
documentation for the chassis.

• Available adjacent, compatible slots—PXIe-5842 VST: 4

■ 3 for PXIe-5842 module
■ 1 for PXIe-5655 module

The modules that compose PXIe-5842 instruments can be installed in the
following PXI chassis slot types:

■ PXI Express Hybrid Peripheral Slot
■ PXI Express System Timing Slot
■ PXI Express Peripheral Slot

• Power delivery—See PXIe-5842 Safety, Environmental, and Regulatory
Information or PXIe-5842 Specifications.

Note Power requirements may be specified on a module basis;
the chassis must provide enough power for the complete PXIe-5842
instrument.

Controller or Host Computer Requirements
• RAM—4 GB. Depending on the amount of data acquired and/or processed, a

larger amount of memory may be required.
• Processor—1 GHz 64-bit (x64)
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PXIe-5842 Software Setup

Choosing Your Software
You can choose among multiple options for taking measurements with the
PXIe-5842.

Depending on the measurements you want to take and how you want to customize
your test system, choose the appropriate software from the following options.
If you want to Choose

Perform physical layer measurements of
supported communications and connectivity
signals

RFmx personalities

Measure spectral performance and understand
spectral characteristics

RFmx SpecAn

Measure modulation quality, including error
vector magnitude (EVM)

RFmx Demod

Create, visualize, and play back RF waveforms RFmx Waveform Creator

Perform custom measurements or applications
that require I/Q data

NI-RFSA

Generate CW or modulated waveforms NI-RFSG

Take interactive measurements with your
instrument

InstrumentStudio

Installing the Software
You must be an Administrator to install NI software on your computer.

1. Install an ADE, such as LabVIEW or LabWindows™/CVI™.
2. Download the driver software installer from ni.com/downloads.

NI Package Manager downloads with the driver software to handle the
installation. Refer to the NI Package Manager Manual for more information
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about installing, removing, and upgrading NI software using NI Package
Manager.

3. Follow the instructions in the installation prompts.

Note Windows users may see access and security messages during
installation. Accept the prompts to complete the installation.

4. When the installer completes, select Restart in the dialog box that prompts
you to restart, shut down, or restart later.
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Installing and Interconnecting PXIe-5842
Instruments

PXIe-5842 Installation and InterconnectionOverview
Follow this general process to complete physical setup for your PXIe-5842
instrument.

Refer to the detailed procedures in this article to complete the following tasks:

1. Unpack your kit.
2. Install the PXI Express modules of your instrument in your PXI Express chassis.
3. Read and understand the guidelines before interconnecting the modules of

your instrument.
4. Interconnect the PXI Express modules of your instrument.

Unpacking the Kit
Notice To prevent electrostatic discharge (ESD) from damaging the
device, ground yourself using a grounding strap or by holding a grounded
object, such as your computer chassis.

1. Touch the antistatic package to a metal part of the computer chassis.
2. Remove the device from the package and inspect the device for loose

components or any other sign of damage.

Notice Never touch the exposed pins of connectors.

Note Do not install a device if it appears damaged in any way.
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3. Unpack any other items and documentation from the kit.

Store the device in the antistatic package when the device is not in use.

Installing PXIe-5842 Modules in a PXI ExpressChassis
You need to install modules in your PXIe-5842 instrument in a specific order and
orientation to facilitate interconnection of the modules into a complete, functional
instrument.

Ensure your PXI Express chassis meets the capacity, power, and slot cooling capacity
requirements of your PXIe-5842 instrument.

Notice To prevent damage to the PXIe-5842 caused by ESD or
contamination, handle each PXI module using the edges or the metal
bracket.

Complete the following steps to install the PXI modules of your instrument in your
PXI chassis:

1. Ensure the AC power source is connected to the chassis before installing the
modules.
The AC power cord grounds the chassis and protects it from electrical damage
while you install modules.

2. Power off the chassis.
3. Inspect the slot pins on the chassis backplane for any bends or damage prior

to installation. Do not install a module if the backplane is damaged.
4. Remove the black plastic covers from all the captive screws on the front

panels for all modules.
5. Select an appropriate set of PXI chassis slots so that you can install the

modules that compose your instrument in the order indicated:

ni.com10

PXIe-5842 Getting Started



Instrument Adjacent Compatible Slots Required

PXIe-5842 VST 4

Instrument Module Installation Order, Left to Right

PXIe-5842 VST
1. PXIe-5842
2. PXIe-5655

PXIe-5842 instruments can be installed in the following PXI chassis slot types:

■ PXI Express Hybrid Peripheral Slot
■ PXI Express System Timing Slot
■ PXI Express Peripheral Slot

Use the following figure to identify compatible slots within your chassis:

Figure 1. Chassis Compatibility Symbols

1. PXI Express System Controller Slot
2. PXI Peripheral Slot
3. PXI Express Hybrid Peripheral Slot
4. PXI Express System Timing Slot
5. PXI Express Peripheral Slot

6. Touch any metal part of the chassis to discharge static electricity.
7. Place the edges of a module of your instrument into the module guides of the

appropriate slot at the top and bottom of the chassis. Slide the module into
the slot until it is fully inserted.

8. Secure the module front panel to the chassis using the front-panel mounting
screws.
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Note All front panel mounting screws must be attached to the PXI
Express chassis to ensure all backplane connectors are fully mated.
Tightening the mounting screws also increases mechanical stability
and electrically connects the front panel to the chassis, which can
improve the signal quality and electromagnetic performance.

9. Repeat steps 6 through 9 for each PXI module within your instrument until you
have installed all PXI modules for your instrument.

10. Cover all empty slots using slot blockers and EMC filler panels.

Note For more information about installing slot blockers and filler
panels, go to ni.com/r/pxiblocker.

11. Power on the chassis.

The in-chassis modules of your PXIe-5842 instrument are now correctly installed in
your PXI chassis.

PXIe-5842 instruments also require interconnections between the installed
modules. Continue with the interconnection procedure for your instrument
according to the interconnection guidelines.

Ensuring Signal Quality when Interconnecting thePXIe-5842
After you install the PXIe-5842 modules into your chassis, you must use the included
cables to interconnect the PXI Express modules to each other and subsequently to
any modules external to the PXI Express chassis. To ensure proper connections that
maintain signal quality, adhere to the following guidelines while interconnecting the
modules.

■  Inspect all RF connectors before attaching mating cables. Clean with
dry compressed air, if necessary, to remove any contaminants that may be
present.
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■  Position RF cables with instrument connectors to ensure center pins are
straight and aligned before mating.
■  For all threaded RF connectors for your PXIe-5842 instrument, engage and
finger-tighten the connector nuts. The connector nuts should thread easily
without binding, but if not, ensure the connector is straight and that center
pins have not been damaged.
■  Carefully tighten all threaded RF connectors to the torque specified in
the interconnection process for your instrument using an appropriate torque
wrench or torque screwdriver and driver bit; tighten only until the wrench
reaches the torque limit.

Notice Incorrect torque at threaded connections can damage
device connectors and degrade signal integrity.

Interconnecting the PXIe-5842 VST
Complete this procedure to interconnect the modules of the PXIe-5842 VST.

Before beginning this procedure, install the relevant modules for your instrument in
your PXI Express chassis and refer to the interconnection guidelines.

All PXIe-5842 instrument configurations include a PXIe-5655 module physically
adjacent to the PXIe-5842 module. These two modules are interconnected in the
same way for all PXIe-5842 instrument configurations.

Complete the following steps to interconnect the PXIe-5842 VST:

1. Connect the local oscillator for RF output.

Cable Torque PXIe-5842 Connector PXIe-5655 Connector

Semi-rigid
2.92 mm (m)-
to-2.92 mm (m),
136104A-01

0.9 N · m (8 lb · in.) RF OUT: LO IN LO 0 OUT

2. Connect the internal reference clock.
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Cable Torque PXIe-5842 Connector PXIe-5655 Connector

Semi-rigid
2.92 mm (m)-
to-2.92 mm (m),
136103A-01

0.9 N · m (8 lb · in.) REF: IN REF OUT

3. Connect the local oscillator for RF input.

Cable Torque PXIe-5842 Connector PXIe-5655 Connector

Semi-rigid
2.92 mm (m)-
to-2.92 mm (m),
136106A-01

0.9 N · m (8 lb · in.) RF IN: LO IN LO 1 OUT

You have now provided the reference clock and LO sources for the PXIe-5842 VST.

Your instrument should appear as follows:
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Figure 2. Interconnected PXIe-5842 VST

1. PXIe-5842
2. PXIe-5655
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3. Semi-rigid 2.92 mm (m)-to-2.92 mm (m) cables

Physical setup for the PXIe-5842 VST is now complete.
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PXIe-5842 Operation Guidelines

Avoiding Damage when Making Direct Connectionsto the PXIe-5842
Because the PXIe-5842 is a precision RF instrument, it is sensitive to ESD and
transients. When you make direct connections to the PXIe-5842, you can avoid
damaging the RF ports by adhering to the following guidelines.

■  Apply external signals only while the hardware is powered on.

Notice Applying external signals while the hardware is powered off
may cause damage.

■  Ensure you are properly grounded when manipulating cables or antennas
connected to the instrument.
■  If you are using non-insulated devices, such as an RF antenna, ensure the
devices are maintained in a static-free environment.
■  If you are using an active device, such as a preamplifier or switch routed
to the PXIe-5842, ensure that the device cannot generate signal transients
greater than the RF and DC specifications of the PXIe-5842.

Avoiding Damage when Removing Modules fromthe Chassis
If you need to move your composite instrument or remove individual modules for
any reason, take care to avoid damaging modules or cables by first disconnecting all
interconnections made between the modules of the instrument.

Notice All interconnections made between the in-chassis modules of
your composite instrument must be disconnected prior to removing any
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modules from the PXI chassis. Failure to do so could result in damage to
the modules or interconnection cables.
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Setting up the PXIe-5842 for Measurements

Configuring the PXIe-5842 in MAX
Use Measurement & Automation Explorer (MAX) to configure your NI hardware. MAX
informs other programs about which NI hardware products are in the system and
how they are configured. MAX is automatically installed with NI-RFSA, NI-RFSG, and
RFmx.

1. Launch MAX.

2. In the configuration tree, expand Devices and Interfaces to see the list of
installed NI hardware.
Installed modules appear under the name of their associated chassis.

3. Expand your Chassis tree item.
MAX lists all modules installed in the chassis. Your default names may vary.

Note If you do not see your module listed, press <F5> to refresh the
list of installed modules. If the module is still not listed, power off the
system, ensure the module is correctly installed, and restart.

4. Record the name MAX assigns to the PXIe-5842 or, if desired, provide a custom
name to the PXIe-5842.
Use this name when programming the PXIe-5842.

5. Associate the hardware modules that compose your instrument.
Instrument Process

PXIe-5842 VST
1. Select the PXIe-5842 module to

associate.

2. In the Associated Devices section,
click the Associated LO dropdown
and choose the PXIe-5655 to associate
with the PXIe-5842 module.

3. Click Save.
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6. Perform an intermediate self-test in MAX.

1. Select the item in the configuration tree and click Self-Test in the MAX
toolbar.

2. Select the Intermediate radio button and then click Start.

The green signal illuminates and shows Pass when the self-test completes
successfully.

Related tasks:
■ What Should I Do if the Instrument Does Not Initialize?

When to Perform Self-Calibration
Self-calibration uses internal elements to adjust the PXIe-5842 for variations in the
module environment.

PXIe-5842 modules are externally calibrated at the factory; however you should
perform a self-calibration in any of the following situations:

■ After first installing and interconnecting your PXIe-5842 instrument
■ After any module in the chassis is installed, uninstalled, or moved
■ After intermodule cabling has been changed, reconnected, or repositioned
■ After changing controllers, computers, or reinstalling the driver software
■ When the system is in an environment where the ambient temperature
varies or the module temperature has drifted more than ±5 °C from the
temperature at the last self-calibration
■ To periodically adjust for small performance drifts that occur with product
aging

Note To ensure specifications before you use the instrument or perform
self-calibration, power on the PXI Express chassis and wait for the
operating system to completely load; and then allow the instrument to
warm up for 30 minutes.
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Note Ensure that any connected external hardware is in an idle
state and not outputting signals during self-calibration. It is not
recommended to perform self-calibration while connected in direct
loopback configurations.

Note For the best image rejection and residual LO performance, run Self
Cal or Self Calibrate Range for the image rejection and residual LO portion
any time the module temperature changes beyond ±1 °C.

Performing PXIe-5842 Self-Calibration
You can self-calibrate your VST either interactively or programmatically; each
method yields the same self-calibration results.

• Interactive methods—Self-calibration in the InstrumentStudio application.
• Programmatic methods—Self-calibration in a supporting programming

environment using an API directly.

■ NI-RFSA

■ Using the RFSA Self-Calibration programming example
■ Using self-calibration functions

■ NI-RFSG: using self-calibration functions
■ RFmx: using self-calibration functions

To get started, choose one of the self-calibration methods, and self-calibrate the
PXIe-5842.

Performing a VST Self-Calibration UsingInstrumentStudio
NI recommends you perform an initial self-calibration using InstrumentStudio.
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NI VSTs are represented in InstrumentStudio as a vector signal analyzer and a
vector signal generator. Performing self-calibration with either representation of the
PXIe-5842 accomplishes the same self-calibration, so it is not necessary to use both
when you self-calibrate the PXIe-5842.

Complete the following steps to self-calibrate your VST with InstrumentStudio:

1. Allow all modules of the PXIe-5842 instrument to warm up for 30 minutes after
the PXI Express chassis has been powered on and the operating system has
completely loaded.

2. Launch InstrumentStudio by navigating to Start » National Instruments »InstrumentStudio.

3. Click File » New » RF Signal Analyzer to create an analyzer panel for the
PXIe-5842.

4. Click the tab created for the PXIe-5842 and click the gear icon ( ) in the upper
right corner of the right sidebar.

5. Hover over Device Slot » Calibration and click Self-Calibrate....
6. Click Continue to proceed.

The PXIe-5842 stores the new calibration data in its nonvolatile memory if the
self-calibration is performed successfully.

Performing a Self-Calibration Using the NI-RFSA LabVIEWExample
Complete the following steps to self-calibrate the PXIe-5842 with the NI-RFSA
programming example:

1. Allow all modules of the PXIe-5842 instrument to warm up for 30 minutes after
the PXI Express chassis has been powered on and the operating system has
completely loaded.

2. Select Start » All Programs » National Instruments » LabVIEW to launch
LabVIEW.
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3. Launch the Example Finder at Help » Find Examples... and navigate to the
example.

1. Select Hardware Input and Output » Modular Instruments » NI-RFSA » Utilities » RFSA Self Calibration.
2. Open the example.

4. Complete the following steps to configure the example:

1. Select the device identifier assigned to the PXIe-5842 in MAX in the[Resource Name] drop-down menu.

2. Set Clock Source to OnboardClock.

3. Set Self Calibration Step Operations to Perform All Self CalibrationSteps.

5. Run the VI.

PXIe-5842 stores the new calibration data in its nonvolatile memory if the self-
calibration is performed successfully.
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Using NI Software with the PXIe-5842

Making a First Measurement
You can verify proper installation and configuration of your device by making a
measurement using InstrumentStudio.

1. Depending on your instrument, connect the relevant RF input and RF output
ports using the appropriate cable.
Instrument Connection

PXIe-5842 VST
■ Ports: PXIe-5842 RF IN to RF OUT
■ Cable: SMA (m)-to-SMA (m)

2. Launch InstrumentStudio at Start » National Instruments »InstrumentStudio.

3. Click File » New » RF Signal Generator.
4. Generate a 1 GHz CW tone RF signal at the RF output terminal of your

instrument.

1. Select CW in the panel for the instrument.

2. In the Frequency box, enter 1 GHz.

3. In the Level box, enter 0 dBm.

5. If the generator is not already running, click Run, and set the output to On.
The instrument generates a signal with the settings you specify.

6. Click File » New » RF Signal Analyzer.
7. Verify on the RF signal analyzer panel that the PXIe-5842 is receiving the CW

tone.
8. Close InstrumentStudio.
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RF API Locations
Access the API to program your instrument, depending on your application
development environment and RF driver.

Table 2. API Location for RFmx

ADE Location

LabVIEW Available on the LabVIEW Functions palette atMeasurement I/O » NI-RFmx.

LabWindows/CVI Available from the LabWindows/CVI Library
menu at Library » RFmx SpecAn Library andLibrary » RFmx Demod Library.

Microsoft Visual C/C++ Use the header files located in the
<NIDir>\Shared\ExternalCompilerSupport\C\inc
lude directory and import library files located in
one of the following directories:

■  32-bit installation—
<NIDir>\Shared\ExternalCompilerSupport
\C\lib32\msvc
■  64-bit installation—
<NIDir>\Shared\ExternalCompilerSupport
\C\lib64\msvc

where <NIDir> is the following location:

Program Files (x86)\National Instruments.

Microsoft .NET For the location of .NET class libraries, refer to
the installed RFmx readme.
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Table 3. API Location for NI-RFSA

ADE Location

LabVIEW Available on the LabVIEW Functions palette atMeasurement I/O » NI-RFSA.

LabWindows/CVI Depending on bitness, available in
the <IVIROOTDIR32>\Drivers\niRFSA or
<IVIROOTDIR64>\Drivers\niRFSA directory,
where <IVIROOTDIR32> and <IVIROOTDIR64>
are the following:

• <IVIROOTDIR32>—Program Files (x86)\IVI
Foundation\IVI

• <IVIROOTDIR64>—Program Files\IVI
Foundation\IVI

Microsoft Visual C/C++ Depending on bitness, use the header files
located in the <IVIROOTDIR32>\Include or
<IVIROOTDIR64>\Include directory and import
library files located in the <IVIROOTDIR32>\Lib
or <IVIROOTDIR64>\Lib directory, where
<IVIROOTDIR32> and <IVIROOTDIR32> are the
following:

• <IVIROOTDIR32>—Program Files (x86)\IVI
Foundation\IVI

• <IVIROOTDIR64>—Program Files\IVI
Foundation\IVI

Microsoft .NET Use the NI-RFSA .NET class library by adding a
reference to
NationalInstruments.ModularInstruments.NIRfs
a.Fx40 or
NationalInstruments.ModularInstruments.NIRfs
a.Fx45 and any dependent class libraries from
within the Solution Explorer in Visual Studio.
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Table 4. API Location for NI-RFSG

ADE Location

LabVIEW Available on the LabVIEW Functions palette atMeasurement I/O » NI-RFSG.

LabWindows/CVI Depending on bitness, available in
the <IVIROOTDIR32>\Drivers\niRFSG or
<IVIROOTDIR64>\Drivers\niRFSG directory,
where <IVIROOTDIR32> and <IVIROOTDIR64>
are the following:

• <IVIROOTDIR32>—Program Files (x86)\IVI
Foundation\IVI

• <IVIROOTDIR64>—Program Files\IVI
Foundation\IVI

Microsoft Visual C/C++ Depending on bitness, use the header files
located in the <IVIROOTDIR32>\Include or
<IVIROOTDIR64>\Include directory and import
library files located in the <IVIROOTDIR32>\Lib
or <IVIROOTDIR64>\Lib directory, where
<IVIROOTDIR32> and <IVIROOTDIR32> are the
following:

• <IVIROOTDIR32>—Program Files (x86)\IVI
Foundation\IVI

• <IVIROOTDIR64>—Program Files\IVI
Foundation\IVI

Microsoft .NET Use the NI-RFSG .NET class
library by adding a reference
to NationalInstruments.ModularInstruments
.NIRfsg.Fx40
or NationalInstruments.ModularInstruments
.NIRfsg.Fx45 and any dependent class libraries
from within the Solution Explorer in Visual
Studio.
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Using the NI Example Finder
If you are using RFmx, NI-RFSA, or NI-RFSG with LabVIEW or LabWindows/CVI, use
the NI Example Finder to locate programming examples.

1. Launch LabVIEW or LabWindows/CVI.

2. Select Help » Find Examples to open the NI Example Finder.

3. Navigate to Hardware Input and Output » Modular Instruments.
4. Open the example that best matches your application requirements.

Finding Microsoft Visual Studio Examples
If you are developing VST applications with Microsoft Visual Studio, locate examples
in the following directories.

Table 5. Location of Microsoft Visual Studio Programming Examples

Software Option Examples Location

RFmx <NIDocDir>\<Personality>\Examples

where <NIDocDir> is the Users\Public\Public
Documents\National Instruments directory and
<Personality> is the directory of your RFmx
personality.

NI-RFSA <NIDocDir>\NI-RFSA\examples

where <NIDocDir> is the Users\Public\Public
Documents\National Instruments directory.

NI-RFSG <NIDocDir>\NI-RFSG\examples

where <NIDocDir> is the Users\Public\Public
Documents\National Instruments directory.
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PXIe-5842 Troubleshooting

Troubleshooting
If an issue persists after you complete a troubleshooting procedure, search our
KnowledgeBase for additional information our technical support engineers create
as they answer common user questions and resolve unexpected issues.

Related information:
■ ni.com/support

What Should I Do if My Hardware Doesn't Appear inMAX?
1. Check that the ACCESS/ACC LED on the hardware is solid green.

2. In the MAX configuration tree, expand Devices and Interfaces.

3. Expand the Chassis tree to see the list of installed hardware, and press <F5>
to refresh the list.

4. If the module is still not listed, power off the system, ensure that all hardware
is correctly installed, and restart the system.

5. Navigate to the Device Manager by right-clicking the Start button and
selecting Device Manager.

6. Depending on your controller type, verify Device Manager settings.
Controller Type Description

PXI controller
1. Verify that a National Instruments

entry appears in the system device list
2. If error conditions appear in the list,

right-click the module you are using
in the Device Manager and selectUpdate Driver.
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Controller Type Description

MXI controller Right-click PCI-to-PCI Bridge and selectProperties from the shortcut menu to
verify that the bridge is enabled.

7. Restart your computer.

Why Is the ACCESS LED Off When the Chassis Is On?
The LEDs may not light until the module has been configured in MAX. Before
proceeding, verify that the module appears in MAX.

If the module appears in MAX but the ACCESS LED fails to light after you power on
the chassis, a problem may exist with the chassis power rails, the hardware module,
or the LED.

Notice Apply external signals only while the hardware is powered on.
Applying external signals while the hardware is powered off may cause
damage.

1. Disconnect any signals from the PXI Express module front panel.
2. Power off the PXI Express chassis.
3. Remove the module from the PXI Express chassis and inspect it for damage.

Do not reinstall a damaged device.
4. Install the module in a different PXI Express chassis slot from which you

removed it.
5. Power on the PXI Express chassis.
6. Restart your computer.
7. Verify that the module appears in MAX.

What Should I Do if the PXIe-5842 Fails the Self-Test?
1. Restart the system.
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2. Launch MAX and perform an intermediate self-test.

1. Select the item in the configuration tree and click Self-Test in the MAX
toolbar.

2. Select the Intermediate radio button and then click Start.

The green signal illuminates and shows Pass when the self-test completes
successfully.
If the self-test fails, review the Detailed Result pane in the 5842 Self-Test
window to identify the specific item(s) causing the failure, and inspect any
cables and connections for the item(s). Address any issues you identify and
perform an intermediate self-test again. If the self-test still fails, continue this
procedure.

3. Power off the chassis.
4. Reinstall the failed instrument in a different set of slots.
5. Power on the chassis.
6. Perform an intermediate self-test again.

What Should I Do if the Instrument Does NotInitialize?
Failure to initialize may indicate a problem with module interconnections or with
MAX.

If the niRFSA Initialize VI or niRFSG Initialize VI returns an error and the PXIe-5842
fails to initialize, complete the following steps:

1. Power off the system.
2. Inspect all PXIe-5842 front panel cables and, if there are no apparent issues,

reconnect cables securely, according to the interconnection procedure for
your instrument.

3. Power on your system and run the MAX configuration and intermediate self-
test procedures.

Related tasks:
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■ Configuring the PXIe-5842 in MAX
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PXIe-5842 Instrument Interface Descriptions

PXIe-5842 Front Panel and LEDs
Note This information applies to the PXIe-5842 module only.

Figure 3. PXIe-5842 Front Panel
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Table 6. PXIe-5842 RF Connector Descriptions

Connector Connector Type Description

RF IN 3.5 mm (f) Input terminal for RF signals
RF OUT 3.5 mm (f) Output terminal for RF signals
RF OUT: LO IN SMA (f) Intermodule connection only
RF OUT: LO OUT SMA (f) Output terminal for exporting

the RF OUT LO signal
RF IN: LO OUT SMA (f) Output terminal for exporting

the RF IN LO signal
RF IN: LO IN SMA (f) Intermodule connection only

Table 7. PXIe-5842 General Connector Descriptions

Connector Connector Type Description

REF: IN SMA (f) Intermodule connection only
REF: OUT SMA (f) Output terminal that can

export a 10 MHz, 100 MHz, or
1 GHz reference clock

PFI 0 SMA (f) Programmable function digital
I/O (DIO) connector for use with
triggers or events

DIO Mini HDMI Reserved
MGT iPass+ zHD Reserved
CTRL Mini HDMI Intermodule connection only
PULSE: IN SMB (m) Reserved
PULSE: OUT SMB (m) Reserved

Table 8. PXIe-5842 LED Indicators

LED Indications

ACCESS Indicates the basic hardware status of the
module.

• Off—The module is not yet functional or has
detected a problem with a PXI Express power
rail
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LED Indications
• Amber—The module is being accessed;

accessed means that you are writing to
the module setup registers to control the
module, reading from the module to monitor
its status, or transferring data to or from the
module

• Green—The module is controllable through
the software

ACTIVE Indicates the state of the module.

• Off—The module is idle
• Solid green—The module is generating a

waveform
• Dim amber—The module is waiting for an

acquisition Reference Trigger
• Solid amber—The module is acquiring a

waveform
• Solid red—The module has detected an

error; the LED remains red until the error
condition is removed
For example, the module could have
exceeded its operating temperature and
entered thermal shutdown. In this case,
check system airflow and reset the module
in MAX.

Note Indicators are listed in
increasing order of priority. For
example, if you are generating a
waveform using NI-RFSG and waiting
on an acquisition Reference Trigger
in NI-RFSA, the LED is dim amber.

© National Instruments 35

PXIe-5842 Getting Started



PXIe-5842 MGT Connector Pinout
Single MGT connector shown; the PXIe-5842 front panel has four MGT connectors that have
identical pinouts.

Table 9. PXIe-5842 MGT Signal Descriptions

Pin Signal Description

A1 Reserved N/A
A2 Reserved N/A
A3 GND Ground reference for signals
A4 Rx+ 0 Receive channel 0, positive
A5 Rx- 0 Receive channel 0, negative
A6 GND Ground reference for signals
A7 Rx+ 3 Receive channel 3, positive
A8 Rx- 3 Receive channel 3, negative
A9 GND Ground reference for signals
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Pin Signal Description
B1 Optical 3.3 V Power supply for active/optical

cables
B2 GPIO Reserved
B3 GND Ground reference for signals
B4 Rx+ 1 Receive channel 1, positive
B5 Rx- 1 Receive channel 1, negative
B6 GND Ground reference for signals
B7 Rx+ 2 Receive channel 2, positive
B8 Rx- 2 Receive channel 2, negative
B9 GND Ground reference for signals
C1 SCL Serial clock
C2 SDA Serial data
C3 GND Ground reference for signals
C4 Tx+ 0 Transmit channel 0, positive
C5 Tx- 0 Transmit channel 0, negative
C6 GND Ground reference for signals
C7 Tx+ 3 Transmit channel 3, positive
C8 Tx- 3 Transmit channel 3, negative
C9 GND Ground reference for signals
D1 Optical 3.3 V Power supply for active/optical

cables
D2 EEPROM 3.3 V EEPROM power supply
D3 GND Ground reference for signals
D4 Tx+ 1 Transmit channel 1, positive
D5 Tx- 1 Transmit channel 1, negative
D6 GND Ground reference for signals
D7 Tx+ 2 Transmit channel 2, positive
D8 Tx- 2 Transmit channel 2, negative
D9 GND Ground reference for signals
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PXIe-5842 DIO Connector Pinout

Table 10. PXIe-5842 DIO Signal Descriptions

Pin Signal Description

19 GND Ground reference for signals
18 VCC +3.3 V power (200 mA

maximum)
17 DIO 7 Bidirectional digital I/O line
16 DIO 6 Bidirectional digital I/O line
15 DIO 5 Bidirectional digital I/O line
14 DIO 4 Bidirectional digital I/O line
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Pin Signal Description
13 GND Ground reference for signals
12 DIO 3 Bidirectional digital I/O line
11 DIO 2 Bidirectional digital I/O line
10 GND Ground reference for signals
9 DIO 1 Bidirectional digital I/O line
8 DIO 0 Bidirectional digital I/O line
7 GND Ground reference for signals
6 GND Ground reference for signals
5 NC No connection
4 GND Ground reference for signals
3 GND Ground reference for signals
2 NC No connection
1 GND Ground reference for signals
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PXIe-5655 Front Panel and LEDs
Figure 4. PXIe-5655 with SMA Front Panel

Table 11. PXIe-5655 Connector Descriptions

Connector Connector Type Description

REF OUT SMA (f) Output terminal that can
export a 100 MHz Reference
Clock.
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Connector Connector Type Description
PFI 0 — This is reserved and not

enabled for use with the
PXIe-5842.

REF IN SMA (f) Input terminal that allows the
use of an external Reference
Clock with one of the following
frequencies:

■ 10 MHz
■ 100 MHz
■ 270 MHz
■ 3.84 MHz × y, where y
is 4, 8, 16, 24, 25, or 32

LO 0 OUT SMA (f) Output terminal for the LO
source. This terminal has no
signal at power on and reset.

LO 0 IN SMA (f) Input terminal that allows
the use of an external local
oscillator.

LO 1 IN SMA (f) Input terminal that allows
the use of an external local
oscillator.

LO 1 OUT SMA (f) Output terminal for the LO
source. This terminal has no
signal at power on and reset.

Table 12. PXIe-5655 LED Indicators

LED Indications

ACCESS Indicates the basic hardware status of the
module.

• Off—The module is not yet functional or has
detected a problem with a PXI Express power
rail.

• Amber—The module is being accessed.
Accessed means that you are writing to the
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LED Indications
device setup registers to control the device,
reading from the device to monitor the device
status, or transferring data to or from the
device.

• Green—The module is controllable through
the software.

ACTIVE
• Off—The module is idle or locked to the

requested reference.
• Solid red—The PLL is unlocked or the

module temperature is out of the specified
operating range.
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